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PREFACE TO THE INSTRUCTOR

Who Should Use This Book?

Paradox for Windows, a bestselling microcomputer database management
system, is by no means used only by computer professionals. Businesspeople
with no interest in, or experience with, computer programming use Paradox for
Windows to help them make better business decisions. Using Paradox for Windows
is designed for the growing number of people who need to master microcom-
puter database management principles and techniques, whether or not they
intend to become computer gurus.

Distinguishing Features

m  Problem-solving Approach. In this increasingly competitive world,
students must learn more than keystrokes; they need to apply Paradox for
Windows to extract valuable information to help make more effective deci-
sions and solve business problems. This book examines the information
needs of a small but growing employment agency. As the agency’s database
grows In size and complexity, students gain confidence in their ability to
apply Paradox for Windows.

& Balance of “What” and “Why.” Each lesson is structured around proce-
dures for creating or processing tables and associated forms, reports, and
queries related to employment agency applicants. These procedures consist
of numbered steps that illustrate what to do; additional unnumbered expla-
nations tell the student why. Carefully selected screen displays help students
progress.

® Integrated Project and Case Study. Paradox for Windows’ applications
are multiple. In each lesson, the ongoing project applies Paradox for Win-
dows concepts and techniques to the employment agency’s job offers. The
ongoing case study processes the database associated with a second smail
but growing business—a college travel club.

®  Coverage of Common Errors. No matter how carefully students follow
directions, they are bound to make an occasional error. Few students are able
to complete all exercises without any detours. This reality is addressed in
every lesson. Marginal notes present a variety of common errors, saving stu-
dents (and an occasional instructor) time and frustration. By addressing these
common errors, students are encouraged to think critically instead of blindly
accepting computer output.
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) ¢ Preface to the Instructor

m  Productivity Tips. Seasoned database specialists’ advice to novices is in the
margin of each lesson. These practical tips will enable students to work
smarter instead of just harder, both in class and throughout their professional
careers.

m  Coverage of Multi-table Facilities. Few real-world applications can be
expressed with a single table. The later lessons step the students painlessly
through multi-table forms, reports, and queries. The text clearly applies the
principles of one-to-one relationships, one-to-many relationships, and refer-
ential integrity—principles that must be mastered to meet information needs.

® Presentation Graphics. Paradox for Windows is a very visual product.
Unlike most of its competitors, it offers extensive graphics capabilities. The
concluding lesson illustrates Paradox for Windows’ graphic power and the
ease with which it can be unleashed.

Comprehensive Instructor’'s Manual with Transparency Masters

The Instructor’s Manual that accompanies Using Paradox for Windows in-
cludes detailed lecture outlines, teaching tips, answers to review questions and
solutions to exercises in the text, and test questions and answers. Solutions are
illustrated by overhead transparency masters.
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PREFACE TO THE STUDENT

Learning Paradox for Windows is a challenge for computer users of the 1990s.
Mastering Paradox for Windows will enable you to create both simple and com-
plex databases and to extract data that satisfies your information needs—
whether you own your own business or work for a small, medium, or large
company or nonprofit organization.

You have three tools to master this material: your teacher, your computer,
and this textbook. Every effort has been made to produce a textbook that will
maximize your learning environment. The Distinguishing Features section in the
Preface to the Instructor describes many of the features in this text that have been
designed to help you attain the goal of applying Paradox for Windows.

In addition, each lesson contains pedagogical features designed with you
in mind:

B Projects, “Try It Yourself,” and Case Study Exercises that test your under-
standing of the lesson’s new Paradox for Windows features and their integra-
tion with features presented in previous lessons.

B Marginal “Common Errors” and “Productivity Tips” that help you work
more efficiently and effectively:.

B Lesson Summary, including a short description of keystrokes, buttons, and
menus introduced in the lesson. These same keystrokes, buttons, and menus
are also compiled in a special section at the end of the book. Mastering Para-
dox for Windows entails much more than becoming familiar with the key-
strokes, but this summary should serve as a handy reference tool throughout
the course and in your careers.

B Review Questions that complement the lesson objectives in determining your
level of understanding.

B  Ready reference material listing, in alphabetical order, all tables, forms,
graphs, and reports used in this text, with a short description and the page
number where the item first appears.

A final word: Keep this book. Sooner or later, you will need to create and apply
databases to help solve your information needs. Remember, if you can’t, some-
one else can.

Levi Reiss
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LESSON

A GUIDED TOUR
OF WINDOWS

This lesson provides a guided tour of the Microsoft Windows 3.1 operat-
ing environment, usually called *Windows.” You must first be familiar with
the basics of this environment, including starting Windows, using the
mouse and the keyboard, manipuiating windows, starting an application,
getting help, and leaving Windows, before you can work with Windows
applications. if you are already familiar with Windows 3.1, try the exer-
cises anyway. You may find that you need fo review selected topics.

Because Paradox for Windows will not run under Windows 3.0 (or older
versions), this text does not discuss Windows 3.0. If you already know
Windows 3.0 but are unfamiliar with Windows 3.1, do all the exercises
and make a special note of any important differences.

Paradox for Windows will be intfroduced in Lesson 2.

You have met this lesson’s objectives when you can:

B Start Windows on your computer.

B Describe the objects in a typical window and indicate their purpose.

® Use the mouse and the keyboard to open, close, maximize,
minimize, and move windows, and to select items from menus.

B Define in your own words the key terms infroduced in this lesson,
and explain their importance to handling windows. Key terms
appear in boldface type and are listed in the Review Questions
section at the end of the lesson.




2 LESSON 1 A Guided Tour of Windows

Starting Windows

The exact process of starting Windows may depend on your hardware and the
technical settings for your specific computer system. The following procedure
should work on your system, with perhaps minor modifications. (Of course,
what some people consider to be minor modifications, others treat as major
problems. Don't rely on your memory. Write down the exact start-up procedure
in your textbook.)

1. Start the computer and type the command to access the appropriate
disk drive, usually C:.

2. Type CD\WINDOWS (upper- or lower-case) and press to change
the current directory to \WINDOWS.

3. Type WIN and press to execute Windows.

4. After a short time, a screen displays announcing Windows. The first
image that remains on the display depends on how Windows was
set up.

Windows Features

Figure 1-1 illustrates a sample window that may be similar to the one that ap-
pears when you start Windows. Let’s examine this window in detail, starting in
the upper-left hand corner.

The Control-menu box appears in the upper-left hand corner of the win-
dow. Selecting this box generates a menu offering you the tools to manipulate
the window and terminate your Windows session.

The highlighted window line is the Title bar; it contains the Control-menu
box, the Window title, and two buttons at the right. In Figure 1-1 the Window

Control-menu Window Title Minimize
box title bar button
Maximize
File Options Window Help button
lcon Scroll box
Vertical
Y scroll bar
Mouse StartUp Main Accessories
Work
areq

FIGURE 1-1

Program Manager
window



title reads Program Manager. Program Manager is the Windows facility used
(among other functions) to start applications such as Paradox for Windows.

The two buttons to the right of the title bar are the Minimize button (an
arrow pointing down) and the Maximize button (an arrow pointing up). Select-
ing the Minimize button reduces the window to an icon, a small picture identi-
fied by a label. Minimizing a window reduces screen clutter without closing the
window. Selecting the Maximize button enlarges the window to the area of the
entire screen, making it easier to see that window’s contents. Maximize a win-
dow when you intend to work in it for some time.

The window’s right edge may include a vertical scroll bar. Using the scroll
bar enables you to view items outside the window’s borders, such as the icon at
the lower right. Selecting the up arrow at the top of the vertical scroll bar moves
the window up, consequently moving the image down the screen. Selecting the
down arrow moves the image up the screen. Note that the square box in the
scroll bar moves as you move (scroll) the image up and down the screen. This
box is called a scroll box. The bulk of the window is known as the body or work
area. The work area may contain data, other windows, or icons.

Figure 1-2 shows the result of maximizing the Program Manager window.
The scroll bar disappears. The second line from the top of the screen is the Menu
bar. The specific Menu bar choices depend on what you are doing. Figure 1-2
shows four menu choices: File, Options, Window, and Help. The next section
tells you how to use the mouse and keyboard to make menu selections. Later in
this lesson, you will explore each menu choice.

Having seen the components of a typical window, you will next learn
about manipulation tools, the mouse and the keyboard. Generally speaking, the
mouse is the preferred tool for telling Windows what you want to do, and for

Menu bar Restore button —

Program Manager

File Options Window Help

Mouse StartUp Main Accessores

B
IS
|® I

Games

Windows Features

FIGURE 1-2

Program Manager
window maximized
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4 LESSON 1 A Guided Tour of Windows

drawing objects such as circles and company logos. Use the keyboard to enter
data (such as names and addresses) and to make menu selections.

The Mouse

The mouse is a pointing tool about the size of a bar of soap, with one, two, or
three buttons. Push the mouse across the desk or special pad to move a high-
lighted object called the mouse pointer across the screen. Initially, the mouse
pointer is an arrow, but its shape may change depending on what you are doing.
To make a selection, position the pointer on a window object and then execute
one of the four mouse actions described below.

Click means to press briefly and let go the left mouse button. For example,
to maximize a window, click on the Maximize button.

Drag means to press the left button and move the mouse without releasing
the button.

TRY IT YOURSELF

Click the mouse on the up and down arrows in the vertical scroll bar and
describe the result. Note what happens to the square box in the scroll bar.

Right-click means to press briefly the right button. Windows itself does not
use the right mouse button. However, to use Paradox for Windows effectively,
you must learn how to right-click.

Double-click means to click the left button twice in rapid succession with-
out moving the mouse. For example, double-click on an icon to launch an appli-
cation such as Paradox for Windows.

TRY IT YOURSELF

Drag the Program Manager titie bar to move the window across the screen.
Next, position the pointer on a window border so that it becomes a two-
headed arrow. Drag the border fo change the window size. Doing so may
generate a horizontal scroll bar at the bottom of the screen (it is similar in
function to the vertical scroll bar previously described). If so, experiment with
the horizontal scroll bar.

The basic mouse operations are not difficult, but you must practice them.
Remember, the mouse is a precision instrument. Keep experimenting as you
work through this text. For many people, the mouse (or more precisely, the
mouse’s use) is an acquired taste.

Figure 1-2 shows the result of maximizing the Program Manager window.
The Restore button in the upper-right hand corner shows an up and a down
arrow. Clicking this button restores the previous window.

The icons displayed in the Program Manager window depend on the instal-
lation. For example, many installations remove the Games icon, for obvious rea-
sons. Among the Program Manager applications, this text utilizes only Paradox
for Windows and Main.



TRY IT YOURSELF

Click the button in the upper-right hand corner of the Program Manager win-
dow to restore the window shown in Figure 1-1, and then click the Maximize
button.

The screen shown in Figure 1-3 is obtained by positioning the mouse
pointer on the Paradox for Windows icon and clicking once. The resultant menu
is called a pop-up menu. Let’s discuss this pop-up menu option by option, start-
ing from the top.

In general, the Restore option displays a window at its previous size. In
this instance, the Restore option transforms the Paradox for Windows icon to a
window occupying the entire screen. The Move option enables you to displace
the Paradox for Windows icon across the screen.

The Size and Minimize options are dimmed, indicating that they are pres-
ently unavailable. For example, the Minimize option is currently unavailable
because Paradox for Windows is an icon and cannot be further minimized.

The Close option closes the menu. To the right of the Close option appears
its keyboard equivalent, Ctrl+F4. To produce this keystroke first press
and, without letting go, press (F4 ). The final menu item, Next, permits you to go
from one application, such as Paradox for Windows, to another on-screen appli-
cation, such as Games. This text does not apply the Next menu item. To remove
the pop-up menu shown in Figure 1-3, simply position the pointer outside the
menu and click.

Figure 1-4 illustrates the opened Paradox for Windows with the applica-
tion icon selected. At this point, you are still working directly in Windows and
have not yet accessed Paradox for Windows. Once again, the actual screen dis-
play will vary. For example, the Collage program, which records and processes
screen images, probably will not appear on your screen. Collage is independent

0Qra anage e | =

File Options Window Help

Pop-up window

Dimmed option

iTii

Maximize

Close Ctrl+tF4 +———— Keyboard equivalent
Next Ctrl+Fb6

Accessories StartUp Games

The Mouse

FIGURE 1-3

Clicking on Paradox for
Windows icon
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6 LESSON 1 A Guided Tour of Windows

Program Manager

File Options Window Help

Paradox for Windows

= & B 2

Clipboard

Configuration  Serial Number Local Settings  Table Repair Readme
E Utility Utility Ltility LItility Viewer
-1
4B i
Helpme ara 0 Collage
(gl VS

Accessories

of Paradox for Windows. Other applications illustrated in this figure are of inter-
est only to specialists.

The next step is to describe the keyboard and apply it to access various
menu options.

FIGURE 1-4

Program Manager and
Paradox for Windows

The Keyboard

The keyboard is an important tool used for data entry and making menu selec-
tions. As is the mouse, the keyboard is a precision instrument.

The File menu appears to the left of the Menu bar in Figure 1-4. If you look
closely, you will see that the “F” in “File” is underlined. To select this menu,
press and, without letting go, press the underlined letter, F or £. This key-
stroke combination is commonly written as F. Furthermore, you must press
before pressing F or £. Press to clear a pop-up menu from the screen.

Locate the arrow keys on the keyboard. Pressing these keys moves a small
highlighted object on the screen—the cursor. In many instances, such as when
choosing an item from a menu, you may move the cursor to the specified item
and press (Enter]. As you become familiar with Windows, and Paradox for
Windows, you will develop your own style for using the mouse and keyboard.
Don’t be afraid to experiment.

TRY IT YOURSELF

Use the keyboard to display and then clear a pop-up menu for each option
offered in the Menu bar of Figure 1-4. Then use the left and right arrow keys

((¢Jand (3)) to access each of these pop-up menus.




Windows provides online Help. Help gives on-the-spot information to get
you out of a jam. Each Windows menu has its own specific Help menu and
facilities. Figure 1-5 shows the initial screen generated when you select the Help
menu from the Program Manager. This particular help screen contains four
menu options and five buttons, as well as on-screen information. Take a little
time to explore Help—it contains a wealth of information.

= Progra anage elp Pt P
File Edit Bookmark Help

Help buttons
Contents for Program Manager Help

Windows Program Manager is a tool you can use to
easily start applications, and organize your
applications and files into logical groups.

To learn how to use Help, press F1.

How To...
Arrange Windows and lcons

Change an lcon

Organize Applications and Documents
Quit'Windows

Start an Application

Switch Between Applications

Commands

File Menu Commands
Options Menu Commands
‘Window Menu Commands

TRY IT YOURSELF

Examine all menus and buttons of the help screen.

Clicking on the Search button of the Program Manager Help screen gener-
ates the output shown in Figure 1-6.

TRY IT YOURSELF

Use the vertical scroll bar to step through the subjects for which help is
available.

Figure 1-7 illustrates the initial contents of the Window menu. The default
option, Cascade, overlaps windows so that each title bar is visible. The Tile
option places open windows so that they fit next to each other. The Arrange
Icons option is used to change the location of icons on the desktop.

The lower portion of the Window menu lists available applications. The
application with the checkmark is Paradox for Windows, the one to be activated

The Keyboard

FIGURE 1-5

Program Manager Help
window
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